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Part 1:
Introduction

What is the purpose of this guide?
Like it’s title suggests, this guide gives you step-by-step instructions on how to use Microsoft’s
PowerPoint to create mouse-operated talking books using pictures scanned in from real books.
It will also look at accessing these talking books using a single switch.

Why do we need talking books?
Access to literature is of crucial importance in the education of all pupils, including those with
special educational needs. There has been a great expansion in the use of storybooks in
schools with a large number of reading books linked to the National Literacy Strategy. The pro-
liferation of big books for group reading and the opening up of literacy into more stimulating
and colourful reading books have especially helped in this expansion into special education.

There are, however, a number of pupils who cannot read independently because of their
physical difficulties. They cannot turn to the next page of a book, skip ahead to find ‘the excit-
ing bits’ or turn back to re-read a page.  They always have to ask someone else to hold their
books and turn the pages for them. Their reading development is often delayed, even if they
are of normal intelligence.

Most of the children visiting the ACE centre can, like our patron Professor Stephen Hawking,
independently access reading materials or books via one or two switches attached to a comput-
er. Children can access electronically published books using a variety of computer access aids 

A page from a PowerPoint talking book 
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including activating a switch with whatever part of their body has the best voluntary control.
Unfortunately, the range of electronically available books for children is very limited and for
disabled children to develop as readers, they need access to the same range of books as other
children. 

It is, however, now possible to create your own books on the computer using hardware and
software that is generally available in schools and many homes. These ‘talking books’ can be
tailor-made to the interests and abilities of the pupils, text can be symbol-supported, and
sounds and speech can be included to enable access to those with reading difficulties.

Children can actively help to make their own accessible talking books, and this opens up
more possibilities of creative and imaginative writing for pupils with learning difficulties.

A well-known example of talking books
is produced by Sherston Software as
the Oxford Reading Tree series (an
example is shown on the right). The
page layout is simple and consistent,
and the controls are clear and straight-
forward. We shall be using a similar
layout to construct our own talking
books.

Our books will be set up initially for
operation by positional mouse switch-
ing, where the left mouse button has

to be pressed when the mouse arrow is over the active icon and the mouse has to be moved
precisely to each of the active areas. This presents difficulties to pupils who can’t control a
mouse or move a pointer accurately, so later on we will be looking at modifying our talking
book to allow access from a keyboard, switch or an overlay board. 

Before you start...
Before you start gathering together piles of books to convert, be aware that putting together
even a single talking book will take time. Creating a template (a master page that contains
the page format and the buttons for turning the pages) at the outset will save hours of time
when making a number of books, but even if you only intend to make one, do create a tem-
plate first.
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Part 2:
Important! 
The copyright issue

There are obviously copyright considerations involved in reproducing pages from printed
books. The publishers of the books used to illustrate this guide have all given express permis-
sion for them to be converted into multimedia by the addition of symbols, as long as copies are
not sold, and the copyright line on the book’s cover is included in the talking book.

There are some guidelines (as of Sept 2001) on copyright issues on the World Wide Web at:

www.pls.org.uk

These are reproduced below. Take particular note of the text in bold (our emboldening),
which sanctions the creation of multimedia copies of books for the personal use of individuals
with visual or physical difficulties. The creation and use of multimedia copies of books for
school and class use by people with special educational needs in schools still seems open to
interpretation. If you are in doubt, contact the publisher, but check that they are aware of the
new guidelines as they may well help your case. 

Joint Industry Guidelines
These guidelines cover access to books, magazines and journals by visually impaired people.
They do not constitute legal advice but are for guidance only:

Introduction 
a These Guidelines are the result of a wide-ranging consultation among rightsholders and

organisations helping visually impaired people in an effort to strike a balance between
the requirements of visually impaired people and the special problems surrounding
uncontrolled copying, transcription and distribution. 

b Rightsholders including authors, their agents and publishers wish to make their works
accessible to all members of the public. 

c Where visually impaired people cannot read works in formats commercially available
they will in some cases wish to copy, record or transcribe the works into a format accessi-
ble to them. The issue of who may create and distribute copies in different formats, in
particular electronic copies, is important for rightsholders. 

d These Guidelines have been drawn up to assist visually impaired users and those acting
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on their behalf to understand current trade practice with regard to acts of copying they
can assume they are allowed to do without requesting prior permission from the rightsh-
older, provided the conditions described below are met. In case of doubt users should
always consult the rightsholder. 

e Rightsholders support the work of charities and volunteer organisations in making books
and journals accessible to visually impaired people. The permissions they require to dis-
tribute such works are outside the scope of these Guidelines. 

f For the purposes of these Guidelines visually impaired people are taken to include blind
and partially sighted persons, those whose sight cannot be improved by the use of cor-
rective lenses, those who are unable through physical disability to hold or manipulate
books or to focus or move their eyes or who are otherwise physically unable to use avail-
able published formats. 

Guidelines
1 Visually impaired people who have lawfully obtained a copy of a published work,

whether bought or borrowed, may make whatever transcription, copy or format changes
they require to enable personal access to the work, including speech synthesis, Braille,
Moon, large print, single voice recording (speech), electronic file, provided the work is not
readily commercially available in a suitable format. 

2 Visually impaired people may ask another person or organisation, including schools,
libraries and charities, to create an accessible copy on their behalf, provided that any
such copy is made for the personal use of the visually impaired person concerned only.
This includes use for the purpose of work or study.

3 A non-electronic copy e.g. single voice recording (speech) or a Braille copy may be bor-
rowed or exchanged among visually impaired people as if it were the print original itself. 

4 Electronic copies may be created and stored on a computer system for as long as
required to enable personal use of the work while the original is retained. They may not
be made accessible or passed on to a third party or posted on an Intranet, in newsgroups
or on the World Wide Web. If the original is lent, sold or given away, then any accessible
copies and associated electronic files must be deleted or transferred with the original. 

5 Visually impaired people must respect the literary and artistic integrity of the work
including any copyright notices and any moral rights the author may have in the work.
They must not in any way adapt, edit, alter, amend or distort the work, other than as
required to enable full access, without the prior permission of the author or his or her
designated representative. 

6 The copyright remains with the copyright owner. Rightsholders retain the right to
exclude the use of certain formats in special circumstances and permission must be
sought for such use from the relevant rightsholders. 

The development of these guidelines has been supported by: 
Association of Authors’ Agents, Association of Learned and Professional Society Publishers, Authors’
Licensing and Collecting Society, Copyright Licensing Agency, Music Publishers Association, National Union
of Journalists, Publishers’ Association, Publishers Licensing Society, Periodical Publishers Association, Scottish
Publishers Association, Society of Authors, Writers’ Guild of Great Britain.
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Each completed PowerPoint talking book file stores all its resources (ie pictures and sounds)
within itself. This has the advantage that you will only need to copy this single file if you want
to transfer it to CD or another computer. However, we strongly recommend that you keep all
your separate picture and sound files, along with the talking book file itself, together in one
folder. They can then be located easily should you need to reuse any of them or create the
same talking book using different software. You need first to decide where you want to create
a new folder to put your resources. Two good options are in My documents, a folder that is
already on most computers, or by creating a new folder on the Windows desktop.

1 Open the My documents folder from the Windows desktop screen:

2 On the File menu, Click on New, and then click Folder:

Part 3:
Creating a folder for
your talking book
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The new folder appears with the temporary name "New Folder":

3 Type a name for the new folder, and then press Return on the keyboard. 

Alternatively you could create a folder on the Windows desktop screen by clicking anywhere on
the screen with the right-hand mouse button and then clicking on New, then Folder:

Rename the folder in a similar way to the first method.
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The instructions given here are based on PowerPoint 2000 but PowerPoint 97 has broadly simi-
lar controls and capabilities.

Start PowerPoint
When you launch the PowerPoint software you
will probably see a window like the one shown
to the right. You won’t be using this method of
opening files, so click Cancel.

Getting the tools for the job
Constructing a talking book is easier if you
begin by setting up the PowerPoint screen
to show all the tools that you will need. To
do this Click on the Tools menu and then on
Customize. Select the Toolbars tab if it is not
already showing.

You will need at least the Drawing and the
Picture toolbars, so put a tick next to them
(The Menu Bar is automatically selected and
you might already have others selected). The
Standard and the Formatting toolbars can
also be useful. Click on Close.

The Picture toolbar may appear in the mid-
dle of your screen. You can move it to one

side by clicking and holding down the left mouse button in its coloured title strip, then drag it
to its new position.

Part 4:
Creating the blank
pages for your book
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Creating a template for your pages
The first stage in the construction of a talking book within PowerPoint is to create a page tem-
plate that you can use for all your books. 

1 Create a blank page
From the File menu in PowerPoint, click New and double click on Blank Presentation. 

Choose the blank
page in the bottom
right hand corner
and click on OK:

2 Add the page turning arrows
To add a forward page turning arrow to the blank page, select the SlideShow menu and
click on Action Buttons:

Click on the forwards arrow ...

... and a small cross will appear in the blank page
instead of the mouse arrow. 

Position this cross
with the mouse at
the bottom right
hand corner of the
page and click the
mouse. The for-
ward arrow button
will appear where
the cross was posi-
tioned and the
Action Settings box
will appear. Click
on OK.

Depending on your version of PowerPoint, a window may appear suggesting that you
save the document. Click No. 
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You can adjust the size and position of the arrow button using the mouse. Click inside
the box with the left mouse button, continue to hold down the button whilst you move
the mouse. The arrow will be dragged to wherever the mouse moves, release the button
to position it. To change the size of the arrow click, hold and drag on the little squares
around the picture of the arrow. Clicking and
dragging the small yellow square alters the size
of the bevel.

Add the back arrow button in a similar manner
by choosing Action Buttons from the Slide Show
menu and selecting a backwards arrow:

Position the arrow
on the page as
before. 

When the Action
Settings box
appears, click OK:

3 Adding a page turning effect
You can make the next page slide in from the top ...

... by clicking on Slide Show...

... and clicking on Slide Transition...

... then choose a transition effect from
the drop-down list (eg Wipe Down)...

... and click on Apply to All:
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4 Don’t add the speaker button yet
The speaker/sound control button is best set up afresh on each page as you create your
talking book. It is better not to create it in the template file.

You now have a slide that can be made into a template file for each page of your talking book.

5 Save the slide as a template
To make this slide into a template file, click on File in the top menu bar, then Save As, and
choose Design Template (or Presentation Template in PowerPoint 97) in the dialogue box
at the bottom. 

Click in the File
name box and give
type in a name, eg
‘talking story’ ...

... then click Save.

The template, in this case called ‘talking story’, will now be available from the New
Presentation menu (see next page) whenever you start PowerPoint. You can use this tem-
plate to create your talking book.

The talking story1 template
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Creating blank pages from the template
We will now create a talking book using the template page (called a slide in PowerPoint). If
PowerPoint is already open, click on File, then New and the New Presentation window will
appear (below). You can also get to this window when launching PowerPoint by choosing the
Template option from the initial screen (shown on page 7).

Click on the General
tab, highlight your tem-
plate by clicking on it,
and press OK. A new
presentation based on
your template will
open.

PowerPoint has a number of control icons at the bottom of the screen that allow different
views of all the slides.

PowerPoint 2000 PowerPoint 97
normal view Slide view Slide view

slide sorter view run a slide show slide sorter view run a slide show

We will use the Slide Sorter View and Normal or Slide View to show all the slides (or
pages) in your talking book as you create them.

To create the correct number of blank pages required for your book, click on the slide sorter
icon, and highlight the blank slide by clicking on it once. Then press CTRL and D together as
many times as you want blank pages for your book. It is easy to add or delete pages at any
time. These slides will automatically be linked to each other by the forwards and backwards
arrows on the blank pages.

Slide sorter view

Normal view
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Part 5:
Adding pictures to
your pages

There are a number of sources for your pictures. You can scan them from a book using a desk-
top scanner, use digital camera photographs, or use clipart and graphics from the computer.
We will look at these three sources in turn.

Adding pictures by scanning from a book
Scanners can be purchased for as little as £50 and some computer sys-
tems already come with one. They work by moving a row of light recep-
tors slowly down the page or picture to be scanned. A certain proportion
of the light is reflected back from the picture which then produces an
electrical signal, building up an electronic image of the page.

You will need to already have a scanner attached to your computer and
set up with it’s own software.

1  Open the scanning window
Go to the first page in your talking book in which you want a pic-
ture to appear and switch to Normal or Slide view (see page 11).
Position your picture in the scanner and click on the Insert menu.

Click on Picture, then choose From Scanner
or Camera. Your scanner’s software should
start.

Clicking on Custom insert will open up the scanning
window, which vary between different models of
scanner and their software. A typical window is
shown overleaf.

A desktop scanner
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All scanner software will have Preview and Scan buttons. Press the Preview button first -
you will get a quick mini-scan of entire scanner bed. In PowerPoint 2000 and 97 you will
have to ensure that the picture is the right way up for the page (if it isn’t, reposition the
page and click the Preview button again). Using the mouse you can drag out a rectangle
on the preview image to mark the area you want to scan. You can usually further adjust
the size and shape of this area by clicking and dragging any of the six small blocks on the
edges of the rectangle. The scanner will then scan only the area that you have marked
out with the mouse. Don’t click the Scan button just yet!

2 Picking the best resolution for scanning your pictures
Somewhere in the settings of all scanning software there will be an area where you can
specify the Resolution (sometimes called Output Resolution) of your final scan. The high-
er the resolution, the larger the file size of the scanned picture, so generally the scanner’s
resolution should be set at 75dpi.

There are lots of other controls you can change in the scanning software to alter the
quality of the image, but unless you have a great deal of time or the final scan of the pic-
ture varies a great deal from the original, I would recommend that you leave these con-
trols alone and just use the default settings. 

3 Scanning your pictures
Click Scan to scan your image. After the scanner has finished, your image will appear on
the screen.

A typical scanning software control window 
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Resizing, moving and cropping the pictures

You can resize your
image if necessary by
clicking and dragging on
its corner frame boxes.
You can reposition the
image by clicking any-
where within it and drag-
ging it to the new
position.

If you have unwanted edges or sections of your scanned image you can use the Crop tool to cut
them away. If you have set up PowerPoint as suggested on page 7, it will already be onscreen
in the Picture toolbar. It may also appear when you click on the picture. If it doesn’t, activate it
by clicking on Tools on the top menu bar, then clicking on Customize and ticking the box next
to Picture. You will only have to this once. Make sure the image is selected by clicking on it,
then choose the Crop tool from the toolbar:

When you move your cursor over any of the small white boxes on the frame of your image and
hold down the mouse button, the crop symbol changes to a small ‘T’ shape. Crop the image by
dragging a relevant cor-
ner or side inwards, then
release the mouse button.
You may need to reselect
the Crop tool each time
you want to carry out a
further crop. Cropping a
picture in PowerPoint can
be a little fiddly and it
does pay to practice (or
persevere).

The Crop tool in the Picture toolbar

Click and drag here
to move the picture

Click and drag here
to resize the picture
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Using digital camera pictures
The use of digital cameras in schools has recently increased considerably due to the advances
in digital camera technologies (they have become much cheaper, with better picture quality
and faster downloading of the photos onto the computer). Digital camera pictures can be
incorporated into talking books in the same way as scanned images. After downloading your
pictures onto the computer using your camera’s software, they can be treated the same as any
other computer graphic.

Using clipart or pictures from the computer
You will probably find a large number of pictures already installed on your computer (Microsoft
Office, for example, comes with a good number of clipart pictures) and you can get many more
pictures and graphics (of varying quality) on commercial CD-ROMS. All can also be incorporat-
ed into your talking books. The Internet can also be a source of picture files (for example
www.clipart.co.uk or images.google.com), and the CALL Centre (callcentre.education.ed.ac.uk)
produce a useful list of clipart websites.

To insert such graphics, go to the Insert menu, click Picture, and choose either Clipart (if
you’re using clipart that’s built into Microsoft office software) or From File (if you’re using pic-
ture files from a different source).
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You can add plain or symbol supported text to the pages of your talking book.

Adding plain text
To write plain text onto your pages, first click on the text box icon which will be in a menu bar
at the top or bottom of the screen, or choose Text Box from the Insert menu.

Click with the left mouse button within the slide and a text box will
appear with the cursor positioned ready for you to type in your text.

You can change the size and the font of your text in the normal
way and you can position your text box anywhere on a page by
clicking and draggingthe edges of the box with the mouse.

Part 6:
Adding text to 
your pages
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Adding symbol supported text
Symbols can also be added to support the text of your talking books. Sources of symbols
include Writing with Symbols from Widgit Software, Inclusive Writer from Inclusive
Technology, Clicker from Crick Software, and Intellipics from Inclusive Technology. 

1 Write your sentences into the symbol processor 
Amend or choose the symbols as you want using the controls within the symbol software and
thicken the lines to at least size 2. It’s best to make your sentence fairly large, but not so large
that the end of it extends beyond the bottom of the screen. The symbol sentence
will look better if the symbol size is set quite large and thick (some computers show
small pictures with jagged edges).

Click on the arrow next to the graphic size box and click on the number 34

Click on the arrow next to the symbol thickness and select 2 or 3

2 Capture the image that’s on the screen
Move the cursor down off the page by pressing the Return key a couple of times at the
end of your sentence. Then hold down the ALT key whilst pressing the Print Screen key to
capture an image of the screen (the Print Screen key is usually towards the top right-
hand side of the keyboard before the numeric keys; it may be called Print Scrn or PrtScr).
Although nothing will appear to happen when the keys are pressed, an image of part of
the screen (called a Screen Dump) is stored temporarily into the computer’s memory,
ready for pasting.

3 Paste the screen image into PowerPoint
Go to the page in your PowerPoint talking book where you want the symbol sentence to
be, and choose Paste from the Edit
menu (or press CTRL and V together
on the keyboard). The screen image
that you captured in step 2 should
appear on the page, probably at the
wrong size, and in need of trimming.

4 If necessary, crop, move and resize
the symbol sentence image
You can now adjust the image of the
symbol sentence using the techniques
described on page 15.
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You can record speech to add to your talking book using a microphone plugged into the com-
puter’s soundcard (all multimedia computers will have a soundcard). Plug the microphone into
the microphone socket in the sound card at the back of the computer. 

There are simple sound recording controls within PowerPoint that are explained below.
However the quality of the recorded sounds using this simple recorder is purely dependent on
the default settings in your soundcard. Lower quality soundcards using the normal basic com-
puter microphones (especially those built into laptop computers) often do not record at a high
enough quality and the resulting speech can sound very distorted. 

Windows comes with its own more advanced sound recorder in the Entertainment folder,
accessed from Accessories in the Start menu. This recorder allows you to have full control over
the sound quality.

It’s worth trying the simple sound recorder in PowerPoint first – if the quality of the recorded
speech is poor then you can use the Windows sound recorder.

Wait! Before you start adding speech or sounds... 
There is one very important change you must make to PowerPoint before you start to add
sounds to your talking book. This is because PowerPoint stores sounds in two different ways:

1 If the sound file is small (ie there is not much speech), the complete sound will be stored
within the PowerPoint pages.

2 When the sound file is large (ie contains a lot of speech and/or music), only a link to the
sound file is stored, and not the sound file itself. This can cause problems transferring the
talking book between computers. You will get a silent talking book!

What we need to do is alter the settings within PowerPoint to allow
larger sound files to be stored within the PowerPoint pages, thus avoid-
ing these problems.

1 Click on Tools, then Options:

Part 7:
Adding speech and
sounds to your pages
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2 In the dialogue box, click on the General tab:

3 Click in the Link sounds box with files greater than and type in 50000 (which is the
biggest number PowerPoint will accept):

This will ensure that all sound files smaller than 50000Kb (5Mb) are included within each of
the pages when you save your talking book. If it is then used on a different computer, the
sounds will play correctly. Five Mb is large enough for all your recorded speech files to be
included.
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So, now to add the speech...
1 Click on the Insert menu, click on Movies and Sounds and then click on Record Sound:

2 This window will appear:
Click on the red record button and speak into
the microphone. Click on stop at the end and
then click in the Name box. Delete the words
"Recorded Sound" and give the speech a
meaningful name  ("Not me said the parrot"
rather than just “sound1”, or “speech2”). 

Then click on OK.

3 A loudspeaker picture will then appear in the middle of your page:

play   stop   record



This can be positioned wherever you want on the slide using the mouse, and resized by
clicking on and dragging the corners of the frame:

This is the first page of your talking book (a background colour has been added in this
example).

Adding extra sound effects 
Sound effects can also be added to liven up the talking books. These can be found from a num-
ber of sources, including the internet. Windows comes with a variety of sounds, as do a num-
ber of other programs. A simple search on your computer will probably reveal a large number
of sound effects (look for files ending in .wav). You can also buy CDs that contain sound effects
- they are often included with clipart and picture CDs.

To add extra sounds to your story, click on Insert on the top menu bar,
then on Movies and Sounds, and then Sound from File. 

This will open a window
(right) from which you
can locate the sound
effect that you require.
If you are adding very
large sound files (music
or video files) to your
talking book it is very
important to make sure
that all of the sound
files are located in the
same folder as the talk-
ing story that you've
created, and that you
insert them from this location. So to add large multimedia files to your talking book you need
first to copy them into your talking book folder and insert them into your talking book.
PowerPoint will always look for the sound in the same folder that contains the presentation, so
this is the best place to put them.
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Completing your talking book
Click on the next blank slide. If you are in normal view, this will be in the panel on the left of
the screen. If you are in slide sorter view, double-click the next blank slide. Add the pictures,
symbols and sounds to create the second page of the story. Follow the same procedure to

make the rest of the pages and check them frequently by clicking
the run a slideshow icon.

Saving your talking book
You can save your PowerPoint talking books in two different ways:

If you save your book as a PowerPoint Presentation it will open with all the menus. To use
it you either click on the run a slideshow icon at the bottom of the screen or press F5.

If you save your book as a PowerPoint Show it will start straight away from your comput-
er when you open it.

To save your talking
book in either of these
formats, choose Save As
from the File menu and
type a name for your
book in the File Name
box. Then choose either
Presentation or
PowerPoint Show from
the Save as type box.
Make sure that you are
saving the book into
the folder that you cre-
ated earlier, then click
on Save.
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Part 8:
Completing and saving
your talking book
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Your talking story can be accessed by using the keyboard, a switch, or a switch attached to an
overlay keyboard. There are also a couple of additional tweaks you can make to your book to
give easier operation for a switch user.

Keyboard access
PowerPoint slideshows - ie talking books - can work from the keyboard in two basic ways called
(rather uselessly in our case) Presented by a speaker and Browsed at kiosk. 

• Presented by a speaker
Here the slideshow is controlled by clicking the left mouse button, or by pressing the fol-
lowing keys on the keyboard:

N, Enter, Page Down, Right Arrow, Down Arrow or the Spacebar all trigger the next 
animation or advance to the next slide.

P, Page Up, Left Arrow, Up Arrow or Backspace all trigger the previous animation or
return to the previous slide.

• Browsed at kiosk (recommended)
If you want the mouse to turn a page only when you click on an arrow (similar to the
Sherston talking stories) and you do not want the keyboard to operate your talking book
then you need to alter the settings to Browsed at kiosk. In this setting the slideshow will
only work when you click on the forward and backwards arrow buttons. 

I would recommend that you set up your shows to be Browsed at kiosk. This ensures that the
pages only advance when the arrow keys are clicked and the slideshow doesn’t respond to gen-
eral presses of the mouse button. It does, however, mean that you can no longer operate the
talking book from the keyboard, but you can still connect a switch or an overlay board.

To change the access settings, click on the
Slide Show menu and choose Set Up Show.

Part 9:
Enabling access to
your talking book
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You can choose
between the main
modes of running a
PowerPoint
slideshow here and
then click OK.

Switch access
There is no easy way to add direct switch access in PowerPoint so that people who can’t use a
mouse can access your talking books. Although you can use utility software like Clikit (from
Intellitools) to create ‘hotspots’ on the page which can be controlled with a switch, results can
be unpredictable. You can, however, connect a single switch to operate a combined speech and
page turn button. 

Once you have set up a combined speech and page turn button (see the opposite page for
instructions on how to do this), Position the mouse cursor over the page arrow and attach a
switch using either a mouse switch box (Semerc Mouser or Tash MouseMover) or a keyboard
switch interface. The keyboard switch interface must be set to send a mouse click (This is pos-
sible, for example, with a Don Johnson keyboard interface, an Inclusive Technology keyboard
switch interface, a Crick switch box or a switch attached to an Intellikeys keyboard).

Position the mouse cursor over the page turn arrow

You should now be able to operate the talking book using a single switch. Make sure that the
cursor remains over the arrow!
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Combining a page turn with speech 
It is possible to set up your PowerPoint talking book so that a single mouse or switch press will
not only turn the page but will also speak the text. To do this, the speech and page turn need
to be combined on one button.

Go to the Slide Show menu and click on Slide Transition:

Click on the Sound box where all your
pages’ sounds will be listed. Choose the
right sound for the page and click on
Apply, not Apply To All. Once again the
importance of giving the sounds a mean-
ingful name really pays dividends here.

Do this for all the pages.

Adding a time delay to a page turn
A further very useful addition to the single press modification described above is to give the
forward arrow a timed delay. This prevent users with a tremor making rapid switch or mouse
presses that would otherwise cause the pages to fly past.

1 Click on the forward arrow button on the
page with the right mouse button.

2 Click on Slide Show, then Custom Animation:

The dialogue boxes for the final steps differ significantly between PowerPoint 2000 and
PowerPoint 97, so we’ve shown both over the page:
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3a If you’re using PowerPoint 2000, click the Action button box...

... and choose
Appear in the Entry
animation and
sound window.

Click on the Order & Timing tab, and select Automatically in the Start animation box. In
the box underneath choose a time delay by using the up/down buttons. We would
advise using 00:02 seconds. Click on Ok.

3b If you’re using PowerPoint 97, choose Appear in the Entry animation and sound window.

Click on the Timing tab, and
select Automatically in the
Start animation box. In the box underneath choose a time delay by using the up/down
buttons. I would advise using 2 seconds. Click on Ok.
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Part 10:
Getting creative with
talking stories

Perhaps one of the most exciting activities involved in making talking books is the creation of
new stories with pupils. These stories can be developed using the pupils’ own language and
can incorporate their own choices. This allows those with learning difficulties real access to
shared and creative writing. 

Commercial talking books with a simple interface are usually targeted for very young chil-
dren with age-appropriate language and topics. There are few talking books on a more adult
level that have the same simple interface.

The books that you create for your own pupils can be on more adult themes. It is possible to
incorporate feelings and activities that reflect young adults’ interests, while keeping the sim-
plicity of layout and control that pupils with learning difficulties need.

There are obviously many different methods in transferring pupils’ ideas and creative writing
to the computer. One method is to start with a story page planner sheet:

Name: Date:

Title:

Picture

text/symbols

Sounds/animation
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Pupils can build these pages into a storyboard, planning out their book by constructing the
individual pages.

I have found it most successful to use a ‘story starter’ that is based on either from a real situ-
ation or the continuation of a story line from a book. 

For example, here is the opening line taken from Metamorphosis by Franz Kafka:

You can develop the storyline by first asking some simple questions, shaping the story from
the pupils’ answers.

• How would Greg feel?
• What would he eat?
• How would he get out of bed?
• What would his family feel?

In this way the story can be developed, in the style of Franz Kafka, with creative writing gen-
erated by the pupils.

Another story we have made into an accessible symbol and talking book on the computer is
The Iron Man by Ted Hughes. You may wish to consider making your own talking book of this
story. The opening chapter from The Iron Man is not only an excellent piece of imaginative
writing, but it contains most of the elements that make for good shared reading; relatively
simple language, repetition, imagination, and well written, almost poetic, prose. It also has the
benefit of a story tape read by Ted Hughes himself that you can use alongside your computer.

All sorts of methds, including Rebus choice sheets and story cubes, can give pupils using AAC
communication methods access to imaginative creative writing. As always, the emphasis is
best put on possibilities, not barriers.

Enjoy your creative writing!
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